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This tutorial has been devised to show what caachéeved with just the basic
drawing facilities in Word. Whether you want to anbe manuals, create
simple brochures, it can all be done with the Diiawlbar facilities. Even if
you think you cannot draw, try it, you will be anedzat what can be achieved
using pre-created shapes and the facilities avail&iith patience, you can
create the most complex diagrams by simply reduttiagn to small
components.

This whole document has been produced using jedetituresavailable on th
Draw Toolbar plus the standard screen grab faahgilable in Windows.

No part of this document may be copied or
incorporated into other works without the
written permission of the author
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If you do not have it already displayed, show the
Drawing Toolbar by selecting View/Toolbars/Drawing
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Tutorial 1
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Click on the Li/re tool

The cursor will change to a cross

Position the “cross” cursor on your
page where you want your line to
start. Hold down the left mouse
button & drag the cursor in the
direction you want your line. Let go
the mouse button at the length you
want the line to be.

TIP — If you hold the shift key down while you
drag out the line it will snap to the nearest 15
angle. For example, if you want a perfectly
vertical line, hold the shift key down and drag
out your line to as near as vertical as you can
and it will snap to the vertic:

Make another line anywhere on the page

Now we are going to alter our first line. Position

the cursor over it (the cursor will change to a

pointer with a cross under it). Holding down the

left mouse button on the line, drag the line to a

new location and let go. .

Click on the line again, the line becomes the >~
active object and anchors (squares) are displayed S
at either end. Click on one of the end squares

(anchor points) and drag it to a new position

You have now learned how to create lines,
reposition them and change their direction and
lenath
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Drawing a grid

Draw a vertical line (if the anchor points are sbbwing,

click on it to show them)

Press Ctrl C and then Ctrl V to copy and pastepdichte
line (if you are more comfortable using the Edill plown
menu to copy and paste then do it that way)

Click on the copy line and move it up so that iaighe right

of the first line

Hold the Shift key down and click on the first linéou
should not have the anchor points showing at tldeoé¢foth

lines

Press Ctrl C and Ctrl V to copy the pair and mdwedopied
lines such that they are all level.

With them all selected, pull up Draw/Align or
Distribute/Align Tor

Select the Draw pointer
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Exercise 1
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and drag it over all 4 lines to highlight all oktin

TIP — If you select an extra object, or miss one,
hold the shift key down and click on the extra ¢
missing one to deselect or select it
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Ungroup
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Rotate or Fiin
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| Set .ﬁ.ut%hape Defauks

O

Pull up the Draw
menu and select
“Group”

Note that if you select
the group now, you get
anchor points that
reflect the group, NOT
the individual lines.

The group can be

JlDLaW*H;é (& | Atoshapes - . w [ O [E

Click and drag ko zalect caveral objeds,

stretched or squeezed just
like an individual item.

Also note that if you need to change a componeat‘group”
that you have created, you will need to “UnGroupliygroup

to get at it
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Exercise 1 - continued

Select the group of 4 lines and use Ctrl C, CttbVhake
another copy of it (or Edit Menu/Copy, Paste)

Select the copy group, pull
up the Draw menu and select
Rotate or Flip/Rotate right

a

; —|
Rotate cr Fli ;
ik : G Free Rotate
= EditHoints de Riotate Left
o+

AN ke might
Set Autoshape Defaults R

I ¥ Ak Flip Horizontal

= 5 .
" Draw = [p (5 | AutoShapes ™ Flip Vertical ﬂ 4 @|
| Page 1 Sec 1 i1 |ar 25" Ln 12 ol 1

Select the Draw pointer. Move the rotated groupopnof the
original group of 4 vertical lines to make yourdyri

You may need to squeeze or stretch either youiceddroup
or your horizontal group to get them to line upaka You
may even need to adjust an individual line but nefer —
you will have to “UnGroup” to get at it

Free rotatiomn

O O m]
Select both the vertical group and the horizontalig and
group these two groups into one. Note that if yaunted to get C =
at an individual line now, you would have to seléghGroup”
twice. = tmy e

Select the “Free rotate” tool

| Draw ~ [}q G

AutoShapes = ™, \DD%A@|%*%?£*ET‘:.HT,

(o] o

4 green anchor points will appear.

Position the cursor over one of these
green corner points and experiment o o'o
dragging it in different directions.
Notice how the group rotates

Once you have chosen your new angle, click on the
Draw cursor to release the free rotate option. o
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Tutorial 2

Basic Objects - Arrows

Arrows are no more than lines with special endsYau can stretch them,
move them, swing them about, change their colodrthitkness just the same
as you learned to do with lines. So here we wét jook at how to choose and
change the arrow styles

Click on the Arrow tool and draw a line. —_—

Colors and Lines | Size | Layouk | Picture | Text Box | YWeh |

—

Click on the Arrows Style tool to get the
selection of end types

Click on the style you want, double or single
ended, open or closed arrow. If you are not happy
with this choice then click on More Arrows
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N More drraws. ..

Fill
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Transparency:
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Line

Select the end style you

Color: (-] e ——-] want, its size, colour and
Dashed: |_ vI wieight !EI.?E F E any other parameter on
offer and click OK
Arrows /
Beqin stvle: | — vl End skwle:
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Tutorial 3
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Click on the Rectangle tool

The cursor will change to a cross 1

Position the “cross” cursor on your page where <
you want the top left corner of your rectangle
to start. Holding down the left mouse button,
drag the cursor to the bottom right corner of —r
your rectangle. Like any drawn object, a

rectangle can be dragged to another location

TIP — If you hold the shift key down while you
drag out the rectangle, it will force a square

I

TIP — You can alter the shape of the rectangle
by dragging any of its anchor points (remembe
to hold down the shift key if you are resizing a
square).
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Click to show the
Fill Color options

| Mo Fil |
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T Click on Red
ROOECEND
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Hore Fil Colors, ..
Fil Effeds. ..




Tutorial 3 - continued

Line Color Cl|ck to ShOW the/
[ Tl | Line Color options

EEEE ol
EEEEEEEE
EDCOEEEEE
B =cmm
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More Line Colars, .,

Click on Yellow

Patterned Lines. ..

Draw another rectangle slightly over the first
one.

Alter the Fill Colour to match the background
colour of your page (in your case probably
white, on this drawing it is the lightest grey.

Alter the Line Colour to match the background.
This shows how we can use shapes of
background colour to eat into other shapes

For example, the diagram at the top of the
previous page is a rectangle and a cross overlayed
with two small rectangles of background colour

You have now learned how to create rectangles
(squares), colour them, move them and reshape
them. You have also learned how to use shapes
to hide bits of unwanted drawing

8




ae Tutorial 4
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Order Layers

Word keeps a note of the order in which you draw
objects. It helps if you imagine them existing on
layers. You can then use the concept to help in
your drawings

Using what you have already learned, create a red
rectangle.

Create a blue circle, slightly over the top of tbd
rectangle.

Draw a horizontal line over the top of the first 2
objects. Make the line 3pt thick

and colour it yellow\

JDLE'W' [+ (% | Agtoshapes = ™ \DD‘ gvévﬁv=zﬁ.@,

i Click on the line theselect “Send t
It Ui back” from the Draw/Order menu
S
H grid,,, !}J Senc to Back
Rotate of Flip v L Bring !j:nrward
. Leh send Backward
E Edit Pairits Bringin Fronk of Tesxk

Set Autoshaps Defaults Bl send Behind Text

B ¥ |
,liDta'N" [f‘i"ﬁi|-':'-gb:|5hapgs+ ST DC}A‘@

| Page 1 Sec 1 11 [t 6.9 Ln3E Cald

Note — “Bring forward” and “Send backward” moves th
object one layer at a time. If you have drawn otiigects
on the page, they may interfere with the positignin

9




Tutorial 5
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Basic Objects - Bendy Lines
This is probably the most difficult thing to masier

the whole tutorial so if you can crack this evenyth
else is down to remembering what tool does what.
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Click on the Autoshapes/Lines/Curve

Once again the cursor changes to a
cross. Position it where you want to
start your bendy line, click then move
the cursor out to the first part of your
bend. Click the left mouse button at
this point and then move the cursor to
the next turning point. Click here and
move the cursor to the next point.
Repeat this process for as many
different bends as you want. Press the
ESC key when you want to finish

your line

2.0

Just like any other drawn object, bendy
lines can be resized by clicking on them
and dragging the displayed anchor points
to ¢ new position

[m] [m]
Zﬂ
[m]

[m]
[m]
[m]
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Tutorial 5 - continued

You may not be entirely happy with your bends.

Don’'t worry — we can alter them.

Click on Draw/Edit points

The system highlights the points you chose
to define your bends. We can drag these to
modify or fine tune our bend. Position the
cursor over any of the points and drag it to a
new location.

More importantly, if we position the
cursor over one of these points and
press the RIGHT mouse key, we get a
whole selection of options. We will just
deal with adding and deleting points
here and cover the remainder later

At this point, you should try drawing a

few curves until you are happy you can
pretty much the bends you want. Then edit
the points to fine tune the over all shape.

BORED YET ?- it’s time to draw something

11
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Click on the Text Box tool
The cursor will change to a cross. +

Position the “cross” cursor on your page where you
want the top left corner of your Text Box to start.

Holding down the left mouse button, drag the >
cursor to the bottom right corner of your Text Box. —

Type your text. Keep typing so that you have more 5
text that can fit in the box and see what happens.
(You have all the typing facilities you have on a
normal Word page

Here we have

o typedtoo much
tewt to Fit i th

Grab any of the anchor points and stretch the box
until you can see all of the text you have typed.

If you want to add a colour background or a box oy

outline colour use the fill colour and line colour
tools \\
If you want to colour the typed text use the font Colouredtext

colour tool

TIP — If you choose No Fill in the Fill Colour
tool & No Line in the Line Colour tool you can
overlay your text on top of other drawn objects
without the backgound colour or box outline
interfering with your drawing

Colouredtext

To reposition a Text Box, position the cursor
onto the edge of the box - the cursor changes to
a «-}% symbol. Drag the box to its new location.

12



Exercise 2

)

Overlaying text

down, drag out a circlesee Tip 1 in Exercise)

Click on the Ellipsé tool and holding the shiftyke +®
\

Click on Line Density tool and select @t

Click on the Text Box tool and drag out a text box. o
Type a 2 and, holding the left mouse button down, 9 ﬁ 9
drag the cursor over it to block it out.

Use the Font Colour tool to change the 2 to red
and, using the main Word tool boxes, select Arial
font, 20 point and Bold

Select No Fill and No Line for the Text Box and
position the cursor on the border and drag it over
your Circle. Hold down the shift key and click on
the circle so that both the circle and the text box
are selected. Select the Draw menu and Group to
group both together. Use Ctrl C, Ctrl V to make a
duplicate (or Edit/Copy ; Edit/Paste)

Block out the 2 and type 35. If you cannot see
the 5 as in this example, you will need to use
the Draw menu/Ungroup to free up the text box
so that you can reshape it to get the 3 & 5 on
one line

Drag the reshaped text box to reposition the
numbers centrally in the circle. Select both the
circle and text box and use Draw menu/Group to
loc them together again.
13
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1. Type your text in a text box We want to rotate this
and select no fill and no line

2. Copy the Text Box and ‘Paste
Special’ as a picture. Don’t
worry about where it gets
pasted, just click on it to
expose the picture boundary

3. Now click on Text Wrapping in
Format Picture toolbox and select
Behind Text

4. Our picture is now a graphic
object that has a rotation handle-
when selected

—

You have to remember that the tex
is not editable, you will have to
repeat the whole process if you nepd
to alter it

14



™ Exercise 3

This exercise is with thanks to Mary Sauer
(msauer.mvps.org) for pointing to the way forward

Before we start, it is important to note that a th
point in time, the text wrapping facilities in WORD
cannot cope with filling what | call "upward holla

1. Either draw your own
freeform shape or choose one
from Autoshapes. For the
purposes of this exercise we

/ are going to use a heart

2. Now we have to draw a mask around it using
the Autoshapes/Lines/Freeform tool. Just do
one half as below. Note — try and get it as\
close as you can. | have exaggerated it to
make it more obvious. Don’t forget you can

use the edit points to improve the shape (see
Let's draw 5 — Drawing a wine glass)

3. Now copy the shape, flip it horizontally and reavinto
position so that the heart is enclosed. Finallyyengour
original heart out of the way and save it somewle¢se
on the page for the moment

Y

15



Exercise 3 - continued

4. Currently, WORD doesn’t support tight text wrap
inside text boxes so here is Mary’s solution: Draw
a 1 x 1 table and reshape the single cell to the si
of your object. Then move your mask over the
cell. Don’t forget you can drag the 1 cell table to
anywhere on the screen

5. It will make things easier if you fill the areas
in which you don’t want text. So for the
example of a heart, you can either add in l%o\
triangles or you can use the edit points to pul
out the existing mask—

6. Remember, if you
type too much in
the cell it will
automatically

/ expand to take it.

7. With some shapes you might wonder why
the text is not close in some areas? Click

on the left heart mask and pull down ‘edit

wrap points’ to display the ‘wrapping’ edv\
contour. Manipulate the wrap points unti

you get the fit you want.

8. Finally, set the cell border to ‘none’ and the
mask lines to ‘no-line’. Colour in your
original shape and bring it ‘behind’ the text

16
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ading & textures

1. Either draw your own shape or choose

one from the Autoshapes selection

2. Tutorial 3 covered solid fill colours and

line colours. Here we are looking at some

of the Fill Effects

3. Make sure your shape is selected

and click on the Fill Color tool\

4. For the first example we will choose a singleoao

with vertical shading and because it is a cylinder

we will choose dark at the outsides and set thke

to light slide falrly low to emphasise the curv

17 OKeith Howell



Tutorial 8 - continued

5. Perhaps we would like to use two colours.

- 6. Select a level of transparency to let text or

objects show through from behind.

18 OKeith Howell




Tutorial 8 - continued

7. Experiment with choosing textures or patterns.

19 OKeith Howell



% Tutorial 9
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A 1. Draw or select your shape

(we are going to use an
autoshape ‘Oval’ figure)

Adding pictures to shapes

2. Select Fill Color/Fill Effects and click on tirecture TAB.
Browse for your picture and click on OK when yowéahe
one you want

And finally you have your
picture inside the shape you
have chosen.

20



Wrapping Text

Tutorial 10

We have 2 fundamental types of wrapping. The f&$b wrap text around a
picture or a graphic where the text is normal typedd processing text (in
line) as in this paragraph. The second type israpvthe text where we are
using pictures and free floating text boxes (ltreatly cannot be done
without an element of trickery — a solution provddey Mary Sauer)

Firstly, picturesn line.

1. Position the cursor in your

text where you want your
picture to appear

At

This is text is here to allow us to —
happens when we—piaymeépwrappmg stylesrasizing. This Is text

is here to allow us to experiment with a picturd aae what happens when
we play around with wrapping styles and resizing.

2. Select the picture you want

This is text is here to allow us to experiment vétpicture and see what

happens when we play around with wrapping stylesrasizing.

21



Tutorial 10 - continued

3. With the picture selected, select Format Pictuoen the
Picture toolbar and click the Layout tab and Adexhc

—_ 4. Select Tight wrapping and
—— Wrap Text Both Sides

\

and see what happens when we play around with \wrggtyles and

resizing. This is text is here to allo
experiment with a picture and see

W us to
what happens

when we play around with wrapping styles and

resizing. This is text is here to allo

W us to

5. Select Horizontal Alignment Right

what happens
ng styles and

put picture on right of your text__|

us to sdmiv
happens when we play with wrapp‘?md

resizing. This is text is here to allo
experiment with a picture and see

W us to
what happens

with different wrapping and resizing. This is tetxt experiment with.

22



Tutorial 10 - continued

This is text is here to allow us to experiment wéthpicture and see what

happens when we play around with wrapping styles
and resizina This is text is here to allow us to

6. Highlight this paragraph and select Justifyat happens when
to straighten the border next to the pictur@d resizingsT
ro—torr o rrero—to—omroroo—to—sperrrerIt. With atyie

and see what happens when we play around with

wrapping styles and resizing. This is text is heye

allow us to experiment with a picture and see what

happens when we play around with wrapping styles

and resizing. This is text is here to allow us to

experiment with a picture and see what happens wesiplay around with
wrapping styles and resizing.

This is text is here to allow us to expe| /- Here we have chosena 4
happens when we play around with wrag ~ Picture within a shape and ;
is here to allow us to moved it into the middle
what happens when we play around with
wrapping styles and resizing. This is
text is here to allow us to
experiment with a picture and
see what happens when we
play around with wrapping styles
and resizing. This is text is here to allow us
to experiment with a picture and see what happens
when we play around with wrapping styles and regjzi

This is text is here to allow us to experiment wéthpicture and see what
happens when we play around with wrapping stylesrasizing. This is text
is here to allow us to experiment with a nicturel zee what hannens when
we play around with wrapping styles an{ 8. Here we have chosen Formg
us to experiment with a picture and se Picture/Layout

with wrapping styles and resizing. T Tab/Wrapping style ‘Behind
experiment with a picture and see whg  Text’ and Picture Tab/Image|
wrapping styles and resizing. This is t4 Control Color = ‘Washout’ |t
with a picture and see what happens ‘wrrermweprayrmarwiomwrappmy
styles and resizing. This is text is here to allemo experiment with a picture
and see what happens when we play around with wrggyles and resizing.
This is text is here to allow us to experiment wathpicture and see what
happens when we play around with wrapping stylekrasizing.

O =
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Tutorial 10 - continued

Wrapping text box text around pictures

Because WORD cannot cope with wrapping text in bextes, if we want to
achieve the same effect we have to create a 1at@¥d (with no border). We
add our picture into the cell and, in this exampéd,its wrapping to tight and
right side only. If we want a picture shape offian a rectangle then insert
your shape e.g. an ellipse and set up its wrappieig use the Fill color/Fill
effects/Picture option to add in your picture.

You can now position your 1 cell table around ydacument to your desired
location.

Don't forget to set the cell and table border tanB@therwise you get a
rectangle printed around your work.

Now is the time for all good
men to come to the aid of
the party. Now is the
time for all good men
to come to the aid of
the party. Now is the
time for all good men to
come to the aid of the party.
the time for all good m'to come to the aid of the party.

24



Tutorial 11

To achieve this we use the WordArt facilit
and will use just one of the font styles (oI
you have learned the following, you will

able to explore the other styles)

1. Click on the Insert WordArt Tool to open the
choice of styles. We are going to use tffe 3

25



Tutorial 11 - continued

Having made your choice you will be presented with
the font edit box where you must type your text.

Type your text e.g. ‘Good graphics are powerfuld afick on OK

Squeeze the sides in
Pull the text round by

dragging the yellow Pull the bottom down to
marker increase the height
Add Autoshapes / Add a circle and fill

Basic shapes/Donut
and stretch it to fit
behind your text

it with a picture or
drawing

26
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1. Draw a closed shape or select one from

Autoshapes/Basic shapes and, with your

shape selected, click on the Shadow tool

2. Select the type of

shadow you want

S

3. Use these 4 to alter

the position and

depth of the shadow

4. Use this to pull Q

down and select

the colour of your

shadow

5. Finally, if you want, use this or the

transparency setting in More Shadow
Colours to render the shadow with
level of transparency

27
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Tutorial 13
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) - Adding Depth

1. Draw a closed shape or select one from
Autoshapes/Basic shapes and, with your
shape selected, click on the 3D Style tool

2. Select the type of 3

3. Use these 4 to alter
the horizontal &
vertical tilt of the
3D effect 4. Use these 2 to alter the
depth and direction of
your 3D effect

5. Use this to alter the direction
& strength of lighting

6. Use this to/

choose the
surface type

7. Use this to
choose the
colour of the
3D effec

NB Use the normal
Fill Color to
colour the face

28



